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2.0 Disclaimer 
 

Ducks Unlimited, Inc. makes no representation or warranty of any kind regarding this material, data and information, 

including, but not limited to, the accuracy of the material, data and information or its suitability for any purpose. All use 

of the material, data and information is at the user’s sole risk. By using any of this material, data and information, the 

user agrees that Ducks Unlimited, Inc. is not responsible for their use of the material, data and information or the results 

thereof. 

 

For additional information about the project, reports, or maps, please contact: Ducks Unlimited, Inc., Great 

Lakes/Atlantic Regional Office, 1220 Eisenhower Place, Ann Arbor, MI 48108, (734)-623-2000. 

  



 
 Ducks Unlimited, Inc.                                                                  6                                    Northeast MN NWI Update Technical Document 

3.0 Introduction 

3.1 Project overview 
The Minnesota Department of Natural Resources (MDNR) has taken the lead in coordinating a multi-agency effort to 

update and enhance the National Wetland Inventory (NWI) for Minnesota. Wetland inventories are an essential tool for 

effective wetland management, protection, and restoration. Such inventories provide baseline information for assessing 

the effectiveness of wetland policies and management actions. These data are used at all levels of government, as well 

as by private industry and non-profit organizations for wetland regulation and management, land use and conservation 

planning, environmental impact assessment, and natural resource inventories. The NWI is the only spatially 

comprehensive wetland inventory for Minnesota. Yet, there are issues with the original NWI data for Minnesota. First 

and foremost, the data are about 25 to 30 years out of date. Second, various limitations in the original technology, 

methodology, and source data resulted in an under representation of very small wetlands, drier-end wetlands, and 

forested wetlands. This Minnesota NWI update will be completed piecemeal by dividing the state of Minnesota into 

multiple project areas. 

3.2 Project area 
The project area for this iteration of the NWI update consists of approximately 14,330 square miles and intersects parts 

of six counties in northeastern Minnesota including: Itasca, Koochiching, St. Louis, Carlton, Lake, and Cook Counties 

(Figure 1) and will be hereafter referred to as the northeast Minnesota project area or simply, the northeast project 

area. 

3.3 Project organization 
Ducks Unlimited (DU) and the Minnesota Department of Natural Resource’s Resource Assessment Office (RA) partnered 

to perform the NWI update for the northeast project area.  DU had primary responsibility for developing the final 

updated NWI and RA had primary responsibility for the LiDAR and DEM processing as well as assisting with the field data 

collection. 

Updating the NWI utilized a hierarchal organizational structure (Fig. 2) that incorporated multiple levels of iterative 

review and opportunities for cross-organizational feedback. DU employed up to four GIS Interns to work on photo 

interpretation and classification of wetlands. A lead image analyst supervised the photo interpretation and had primary 

responsibility for the quality assurance/quality control process as well as incorporating the updated NWI into a seamless 

database. A database administrator and programmer employed by DU was responsible for custom tool development, 

including the simplified plant community classification and Hydro-Geomorphic (HGM) classification and any web based 

management and information sharing tools. DU worked with a private contractor and experienced image analyst to 

develop automated image segmentation methods. All of DU staff reported to a project manager who coordinated and 

oversaw all project activity. The DU project manager worked closely with staff from the Minnesota DNR RA and 

communicated directly with the Minnesota DNR Wetlands Monitoring Coordinator, who reported to the Technical 

Advisory Committee. The Technical Advisory Committee includes personnel from the Minnesota DNR, the United States 

Fish and Wildlife Service, and the University of Minnesota and oversaw the completion of the NWI update for the state 

of Minnesota. 
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Figure 1:  Map of the northeast Minnesota project area. 

 
 

 
Figure 2:  Organizational structure for the northeast Minnesota NWI update project. 
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4.0 Data 

4.1 Projection 
The NWI update for the northeast project area in Minnesota used the UTM projection, Zone 15N and the NAD83 datum 

with linear unit meters.  All data layers used this spatial reference.  The final products were also projected to Albers 

Equal Area Conic Projection, NAD83 to conform to the spatial reference set by the U.S. Fish and Wildlife for NWI data. 

4.2 Primary data layers 
The primary data layers for this project were the layers used in the image segmentation and/or the photo interpretation 

process. 

4.2.1 Seamless updated NWI 
A seamless NWI geodatabase was created for the East-central project area and includes the Koochiching and Duluth 

project areas.  This same geodatabase was utilized to incorporate the final updated NWI for the Northeast project area. 

4.2.2 Spring aerial photos 
The primary image data set for the NWI update was the 2009 4-band, digital ortho quarter quads, spring leaf-off aerial 

imagery (http://www.mngeo.state.mn.us/chouse/airphoto/nemn09.html) (Fig. 3).  The imagery was acquired from the 

State and covers the entire Northeast MN Project Area. Cook, Lake, and St. Louis Counties as well as a portion of Carlton 

County were flown with a spatial resolution of 0.5 meter. Koochiching County and portions of Itasca, St. Louis, and 

Carlton Counties were flown with a spatial resolution of 0.3 meter.  This means the NWI update for the northeast 

project area should be considered current to the year 2009. 

 

 

 
  0.5 meter, 4-band, spring imagery    0.3 meter, 4-band, spring imagery 
 

Figure 3. The spring aerial imagery for the northeast project area. 
 
 
 

http://www.mngeo.state.mn.us/chouse/airphoto/nemn09.html
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4.2.3 Summer aerial photos 
State-wide summer aerial photos have been flown by the Farm Service Agency (FSA) National Agriculture Imagery 
Program (NAIP) in 2008, 2009, and 2010.  The 2008 imagery is 4-band, ortho-rectified imagery, while the 2009 and 2010 
imagery is natural color (3-band), ortho-rectified imagery. (http://www.mngeo.state.mn.us/chouse/airphoto/fsa.html) 

4.2.4 LiDAR data 
LiDAR (Light Detection and Ranging) is an active remote sensing technology that operates on the power of laser light to 

detect and measure surface features on the earth. This data is particularly valuable for representing the topographical 

variation across a landscape. LiDAR data is available for the entire northeast project area at a spatial resolution of 3 

meters.  

4.2.5 Lake bathymetry (DEM)  
This layer does not include bathymetric information for all lakes in the northeast project area, but was used where 

available for the semi-automated delineation of the limnetic and littoral subsystem boundary within the lacustrine 

system of the Cowardin classification system as part of the segmentation process described in section 7.6.  The 

bathymetric data is available from the Minnesota Geospatial Commons at https://gisdata.mn.gov/dataset/water-lake-

bathymetry.  

 

 4.3 Ancillary data layers 
The ancillary data layers were used for creating the training data for the wetlands probability layer and for assisting with 

the photo interpretation.   

4.3.1 Fall peak color aerial photos 
The MN DNR has flown fall peak color aerial photos (3-band natural color) that covers the entire project area (Fig. 4) and 

assisted in interpreting forested wetlands and determining water regime. 

 4.3.2 SSURGO soils data 
The Natural Resources Conservation Service (NRCS) produces soils maps in GIS format (Soil Survey Geographic Database 
[SSURGO]) from the original soil survey maps.  These maps can be very useful in identifying wetlands using various 
combinations of attributes contained within the SSURGO database.   The SSURGO database was available for the entire 
northeast Minnesota project area.  Additional information can be found and data can be downloaded at 
http://websoilsurvey.sc.egov.usda.gov. 

4.3.3 Native Plant Communities 
The Minnesota County Biological Survey collects information on high-quality, native plant communities.  The Minnesota 

County Biological Survey locates higher quality native plant communities using aerial photo interpretation followed by 

field survey of selected sites. The native plant communities dataset can be downloaded in GIS format from the 

Minnesota Geospatial Commons at https://gisdata.mn.gov/dataset/biota-dnr-native-plant-comm.   

4.3.4 MNDNR Forest Stand Inventory 
The Minnesota DNR Foresters aggregate spatially explicit information on forest stands that occur on state-owned 

property.  The resulting dataset provides a description of each distinct stand including main cover type and 

physiographic category, and are often field verified. The forest stand inventory dataset can be downloaded in GIS format 

from the Minnesota Geospatial Commons at https://gisdata.mn.gov/dataset/biota-dnr-forest-stand-inventory.   

http://www.mngeo.state.mn.us/chouse/airphoto/fsa.html
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Figure 4. The fall aerial imagery that intersects the northeast project area. 
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4.3.5 USGS 1:24,000 DRG 
The topographic maps from the USGS are made available as digital raster graphics (DRG) and were used to assist in the 

classification process. 

4.3.6 U.S. Fish and Wildlife Service National Wetland Inventory 
The FWS administers a seamless version of the original NWI as part of the National Map in an ArcSDE master 

geodatabase format.  The importance of the original NWI should not be overlooked when making classification 

decisions.  While the base imagery for the original NWI was not ideal for detailed wetland classification, it was 

accomplished with experienced photo interpreters using stereo pairs.  This information can provide valuable historic 

information regarding the hydrologic regimes, classes and boundaries that can be used to inform the current 

classification process as long as the interpreter understands the limitations of the dataset.   

4.3.7 Wetland restoration sites 
Ducks Unlimited has a point file for all of its wetland restoration projects.  This layer can be helpful in identifying newly 

created wetlands and determining wetland class. 
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5.0 Cowardin Classification System guidance for Minnesota 
 

The primary classification system used for the National Wetland Inventory (NWI) was described by Cowardin et al. 

(1979). All wetland classification definitions for the update of the Minnesota NWI follow Cowardin et al. (1979) and Dahl 

et al. (2009) unless otherwise noted below.  The following section describes the valid codes and descriptions of the 

Cowardin classification system as applied to the NWI update for the northeast project area. A full list of valid codes is 

provided in Table 1.  For examples of the NWI classes and how they were interpreted, please see the Photo 

Interpretation Guide for the Minnesota NWI Update (Ducks Unlimited 2016). 

Table 1: Valid codes for NWI update of Minnesota 

System Subsystem Class Subclass Water Regime 
Special 
Modifier 

L L1 UB   H, K h, x 

            

L  L2 UB   F, H, K b, d, h, x 

    AB   F, H, K b, d, h, x 

    EM 2 F, H, K b, d, h, x 

    US   A, C, K b, d, h, x 

    RS   A, C, K b, d, h, x 

    RB   F, H, K b, d, h, x 

            

P    UB   F, H, K b, d, h, x 

    AB   F, H, K b, d, h, x 

    EM 1 A, B, C, F, K b, d, f, h, x, q 

    EM 2 C, F, H, K b, d, h, x,  

    FO 1, 2, 4 A, B, C, F, K b, d, h, x, q 

    SS 1, 2, 3, 4 A, B, C, F, K b, d, h, x, q 

    US   A, C, K b, d, h, x 

    RB   F, H, K b, d, h, x 

    ML   B d, q 

            

R R2 UB   H h, x 

    AB   H h, x 

    US   A, C h, x 

    EM 2 F, H h, x 

    RS   A, C h, x 

    RB   H h, x 

          h, x 

R R3 UB   F, H h, x 

    US   A, C h, x 

    RS   A, C h, x 

    RB   F, H h, x 

            

R R4 SB   A, C h, x 

 

 



 
 Ducks Unlimited, Inc.                                                                  13                                    Northeast MN NWI Update Technical Document 

5.1 Cowardin classes 
The Cowardin classification system is a hierarchical system developed to standardize the classification of wetlands and 

deepwater habitats of the United States. At the highest level are five systems: marine, estuarine, riverine, lacustrine, 

and palustrine. Only three of these systems are relevant to the inland wetlands found in Minnesota: riverine, lacustrine, 

and palustrine. Santos and Gauster (1993) included a list of valid Cowardin wetland types for Minnesota in their regional 

user’s guide to the National Wetland Inventory Maps. 

Within the riverine and lacustrine systems, there are subsystems. Minnesota has lower perennial rivers, upper perennial 

rivers, and intermittent streams for riverine subsystems. There are no tidal riverine systems. There are also two 

lacustrine subsystems, limnetic and littoral. The palustrine system has no subsystems. Within each of these systems and 

subsystems there are several classes that are defined either on the dominant vegetation (e.g. scrub-shrub and forested) 

or the dominant substrate (e.g. unconsolidated bottom). Additional details of the classification system including the 

definition of each system, subsystem, class, and subclass can be found in Cowardin et al. (1979) and Dahl et al. (2009). 

Valid classes for the remaining systems and subsystems were derived from Cowardin et al. (1979). These wetland classes 

are listed in Table 2.  

General guidance followed for wetland classes:  

 All wetland polygons would be classified to the Cowardin class level.  

 Estuarine and marine systems and the tidal riverine system would not be used. 

 Use of subclasses would be limited to emergent, scrub-shrub, and forested wetlands and must be identified for 

these classes (section 5.2). 

 Only the systems, subsystems, and classes listed in Table  2 should be used for the NWI update. 

 Mixed classes would be allowed as specified by Dahl et al. (2009), but should be minimized (section 5.1.1). 
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Table 2: Valid classes for NWI update of Minnesota 

 

5.1.1 Mixed classes 
Mixed classes were avoided wherever possible (i.e. areas of homogenous classes were delineated as separate polygons).  

In cases where the classes were interspersed without clear spatial definition of the classes, the mixed classes were 

limited to: FO/SS, FO/EM, SS/EM, UB/SS, and AB/SS with no reciprocals. 

System Subsystem Class Code 

Lacustrine 

Limnetic Unconsolidated Bottom L1UB 

Littoral 

Rock Bottom L2RB 

Unconsolidated Bottom L2UB 

Aquatic Bed L2AB 

Rocky Shore L2RS 

Unconsolidated Shore L2US 

Emergent L2EM 

Palustrine  

Rock Bottom PRB 

Unconsolidated Bottom PUB 

Aquatic Bed PAB 

Unconsolidated Shore PUS 

Moss-Lichen PML 

Emergent PEM 

Scrub-Shrub PSS 

Forested PFO 

Riverine 

Lower Perennial 

Rock Bottom R2RB 

Unconsolidated Bottom R2UB 

Aquatic Bed R2AB 

Rocky Shore R2RS 

Unconsolidated Shore R2US 

Emergent R2EM 

Upper Perennial 

Rock Bottom R3RB 

Unconsolidated Bottom R3UB 

Rocky Shore R3RS 

Unconsolidated Shore R3US 

Intermittent Streambed R4SB 
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5.2 Wetland subclass 
The historical application of the Cowardin subclasses in the Minnesota NWI is inconsistent with current guidance. Some 

historical subclasses such as subclass 5 for palustrine emergent wetlands were used in Minnesota, but have been 

abandoned in recent guidance or re-purposed (Dahl et al. 2009). In addition, many of the subclasses are difficult to 

reliably determine using remote sensing data. For this reason, the federal wetlands mapping standard (FGDC 2009) only 

requires subclasses for the emergent, scrub-shrub, and forested classes. 

General guidance followed for subclasses:   

 Subclasses would only be used for scrub-shrub, forested, and emergent wetland classes and must be identified 

for these classes.  

 Whenever possible, the most specific subclass, such as broad-leaved deciduous (PFO1) would be used instead of 

the more generic subclasses, such as deciduous (PFO6).  

 There are no broad leaved evergreen tree species in Minnesota, so that subclass (PFO3) would not be used. 

However, there are broad-leaved evergreen shrub species (PSS3).  

 Based on discussions of the technical advisory committee, sub-class 5 (dead) for both scrub-shrub wetlands and 

forested wetlands should be avoided. Wetlands would be classified based on the dominant (>30% cover) living 

life form or substrate. 

 Valid subclasses for the Minnesota NWI are in Table 6. 

 Mixed subclasses on forested and scrub-shrub classes would be avoided if possible (section 5.2.1) 

 

Table 3: Subclasses for the NWI update of Minnesota 

Class Subclass 

Emergent 1-Persistent 
2-Nonpersistent 

Scrub-Shrub 1-Broad-leaved deciduous 
2-Needle-leaved deciduous 
3-Broad-leaved evergreen 
4-Needle-leaved evergreen 
6-Deciduous* 
7-Evergreen* 

Forested 1-Broad-leaved deciduous 
2-Needle-leaved deciduous 
4-Needle-leaved evergreen 
6-Deciduous* 
7-Evergreen* 

 * The more specific subclasses were used whenever possible. 

5.2.1 Mixed subclasses 
Mixed subclasses on forested and scrub-shrub were avoided wherever possible (i.e. areas of homogenous subclasses 

were delineated as separate polygons).  In cases where the classes were interspersed without clear spatial definition of 

the subclasses, the mixed classes were limited to: 1/2, 1/3, 1/4, 2/4 and 3/4 with no reciprocals.  
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5.3 Water regime modifier  
To fully describe wetlands and deepwater habitats, one must apply certain modifiers at the class level or lower. The 

water regime modifier describes the hydrologic characteristics of the wetland including the frequency and duration of 

inundated or saturated conditions. Because detailed hydrologic records are seldom available, the assignment of water 

regime modifiers relies on interpretation of water levels from images taken at various times as well as interpretation 

based on the plant communities. 

There are some differences in water regime definitions between various guidance documents (Cowardin et al. 1979; 

Santos and Gauster 1993; Dahl et al. 2009). The Minnesota NWI update uses the water regimes A, B, C, F, H, and K as 

defined by Dahl et al. (2009). There are no tidal or sub-tidal water regimes. The Minnesota NWI update does not use the 

E water regime (seasonally flooded – saturated) due to its potential overlap with the C water regime.  The Intermittently 

Flooded (J) water regime is generally considered to only occur in the western United States. This water regime is also 

excluded from the Minnesota NWI update. In addition, due to the difficulty in determining the difference between 

Intermittently Exposed (G) and Permanently Flooded (H) with limited temporal data, the G water regime is not used. 

Given limited temporal data (typically only one spring image, one fall image, and a summer image from each of a few 

relatively recent years ), it is difficult to classify water regime on the basis of water observation alone. Therefore, it was 

important to make inferences based on plant community, landscape position, and other factors. Fortunately, Cowardin 

et al. (1979) simplifies this task somewhat by restricting the water regimes for each class to only a few possibilities. In 

addition, water regimes are further restricted somewhat by regional wetland characteristics. For example, Cowardin 

allows for forested wetlands to have all water regimes except sub-tidal regimes. However, Minnesota does not have any 

tree species that can tolerate permanent or semi-permanent flooding (like Cypress). This is further supported by the 

statistics for water regimes in the original NWI for Minnesota.  

General guidance followed for water regime:  

 Water regime modifiers would be applied to all wetland polygons.  

 Only the A, B, C, F, H, and K water regimes as defined by Dahl et al. (2009) would be used in Minnesota.  

 The (E) water regime from Dahl et al. (2009) would not be used. Instead, it would be incorporated into the (C) 

water regime. 

 Due to the potential difficulty of reliably separating F, G, and H water regimes without long-term hydrologic 

records, the G water regime would not be used. Instead wetlands with more permanent water regimes would 

be classified as either semi-permanently flooded (F) or permanently flooded (H). 

 The (J) water regime would not be used. 

 Water regimes for each valid Cowardin class are listed in Table 4, with most-likely water regimes indicated by 

the abbreviation “ML”. 
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Table 4: Water regime modifiers for the NWI update of Minnesota 

 Water Regime 

Cowardin Class A B C F H K 

L1UB     ML P 

L2UB    P ML P 

L2AB    P ML P 

L2EM    P ML P 

L2US ML  P   P 

L2RS ML  P   P 

L2RB    P ML P 

PUB    P ML P 

PAB    P ML P 

PEM P P ML P P P 

PFO P ML ML P  P 

PSS P ML ML P  P 

PUS ML  P   P 

PRB    P ML P 

PML  ML     

R2UB     ML  

R2AB     ML  

R2US ML  P    

R2EM    ML P  

R2RS ML  P    

R2RB     ML  

R3UB    P ML  

R3US ML  P    

R3RS ML  P    

R3RB    P ML  

R4SB ML  P    

* The most-likely water regimes are indicated by “ML”. Possible, but not-likely, water regimes 

are indicated by “P”.
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5.4 Special modifier  
Special modifiers were used extensively in the original NWI and are used in the NWI update for Minnesota (Table 5). The 

most commonly used special modifier in the original NWI for Minnesota was the (d) modifier for partly drained or 

ditched. Many of Minnesota’s wetlands are partly drained or ditched and this characteristic is readily interpretable from 

most aerial imagery. The application of special modifiers for beaver impacts and excavated wetlands were also 

frequently used. As with the partly drained wetlands, these characteristics are often readily identifiable from aerial 

photos.  

Little used modifiers include the modifiers for farmed, artificial substrate, and spoils. The farmed modifier was 

infrequently used at least in part due to policy decisions not to map most farmed wetlands in the original NWI for 

Minnesota. The current policy is to map these farmed wetlands, where they exist, and so the f modifier was used in the 

NWI update for the northeast project area. The typical farmed wetland in Minnesota is usually a depression that is wet 

in the spring and it shows signs of cultivation. It may be cropped during the summer, but crop stress is often evident.  

Please see the Photo Interpretation Guide for the Minnesota NWI Update for examples of identifying farmed wetlands. 

Based on discussions with the technical advisory committee, the spoils modifier (s) would not be used in the NWI update 

for Minnesota. In addition, the artificial modifier (r) would not be used in the NWI update for Minnesota.  Wastewater 

ponds are coded as PUBKh. 

A new modifier was proposed specifically for the Minnesota NWI update. Wetlands that have peatland (bog/fen) 

signatures (typical vegetation may include Sphagnum, Leatherleaf, Sedges, Black Spruce, and Tamarack) are assigned the 

(q) modifier. Peatlands are readily identifiable from color-infrared imagery (Hop et al. 2000). 

General guidance followed for special modifiers:   

 Special modifiers would be applied using the definitions provided by Dahl et al. (2009), except that the special 

modifier for spoils (s) and artificial (r) would not be used. 

 Farmed wetlands would be identified whenever possible using the guidance in the Photo Interpretation Guide. 

 An additional special modifier was added and applied to indicate peatlands (based on the presence of Sphagnum 

peat mat or other peatland indicators).  

 Wastewater stabilization ponds would be coded PUBKh. 

 

Table 5: Valid special modifiers for the NWI update of Minnesota 

Special Modifiers 

Beaver (b)  
Partly drained/ditched (d) 
Farmed (f) 
Diked/impounded (h) 
Peatland (q)  
Excavated (x) 
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5.5 Water chemistry modifier issues 
The water chemistry modifiers were virtually ignored in the original NWI for Minnesota. Only four polygons were 

associated with water chemistry modifiers. Certain peatlands identified with the special modifier (q) are likely to be 

acidic, but pH cannot be reliably determined from remote sensing data. Therefore, water chemistry modifiers are not 

applied to wetland classification codes for the NWI update for Minnesota. 

5.6 Soil modifier issues 
The original NWI did make some use of the soils modifiers, but their use was inconsistent. The most reliable mapped 

information on soils in Minnesota is from the USDA Soil Survey Geographic (SSURGO) Data. Application of soil modifiers 

in the absence of additional field work would be no better than simply relying on SSURGO. Therefore, soil modifiers are 

not applied to wetland classification codes for the NWI update for Minnesota. 
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6.0 Field verification 
 

The field verification would serve three purposes: 1) to train the interpreters though on-the-ground experience, 2) as 

site based photos for inclusion in the photo interpretation guide, and 3) to provide quality assurance data for review.  

The field verification occurred at three different times: fall 2013, spring 2014, and fall 2014.  Staff from DU assisted the 

RA staff with the field verification in the fall of 2013 so they can gain on-the-ground experience with the wetlands in 

northeastern MN.  The RA staff was responsible for the field work in the spring of 2014 and fall of 2014.   

The original NWI was used to identify wetland types to field visit for the fall of 2013.  A stratified sample of the wetland 

types was selected based on accessibility and efficiency.  The field verification crew was provided with a laptop and the 

wetland polygon location.  The crew recorded the MN NWI class, subclass, water regime and special modifiers for the 

site along with a general description and took a digital photograph of the site.  The field-verified information was 

compared to the original NWI classification and sites with discrepancies were further examined.  A determination of the 

proper code was made by a consensus of the image interpreters.  In cases of confusion, the MN DNR and FWS NWI 

coordinator were consulted.  The field verification in the spring of 2014 and fall of 2014 was performed by the MN DNR 

Resource Assessment staff.  DU provided the RA staff locations of wetlands that were difficult to determine from the 

photo interpretation process or unique classes that can be added to the photo interpretation guide.  
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7.0 Data processing 
 

7.1 Spring aerial photos 
The Minnesota NWI update for the northeast project area conducted by Ducks Unlimited and the MN DNR Resource 

Assessment group utilized two resolutions of imagery (30cm and 50cm pixel resolution) for image interpretation and 

segmentation for the purpose of wetland delineation and labeling for incorporation into the updated NWI database.  

After considerable difficulty in identifying a set of image segmentation parameters that would produce comparable 

results in both image resolutions, a solution was proposed which entailed resampling (coarsening) the 30cm resolution 

data to the same spatial resolution as the 50cm data available for the majority of the project area. The 30cm imagery 

was retained and used for photo-interpretation tasks but for the purposes of automated image analysis the resampled 

data allowed for a single unified set of processing algorithms to be applied across the entire project area.  

In order to ensure the resampling step would not compromise the quality of the final database a small evaluation was 

developed to test alternative resampling methods with respect to the image segmentation process. The resampling 

evaluation yielded visual and segmentation results similar to the imagery acquired and delivered at 50cm resolution 

(50cm base). Therefore, the 30cm data was resampled to 50cm for the purposes of image segmentation for this project. 

 

 

 

Figure 5. Segmentation based on data resampled to 50cm resolution displayed over the original unaltered 30cm 

imagery at a scale of 1:1000. 
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7.2 LiDAR/DEM processing 
Several topographic metrics or indices were derived from the LiDAR data. These derived metrics and indices provide a 

greater ability to discriminate wetland from upland than the DEMs alone.  These derivatives are described in the 

following sections and were produced and provided to DU by the RA staff.   

 7.2.1 Slope 
Slope represents the rate of change of the elevation for each digital elevation model (DEM) cell.  Slope is normally 

output into degree or percent rise.  However, the compound topographic index (CTI, as described below) has better 

results with the slope expressed in radians.  Therefore, the slope was calculated in degrees and converted to radians.  

Areas with low slope (flat areas) are more likely to be wetlands than areas with high slope. 

7.2.2 Topographic Position Index (TPI) 
TPI values provide a simple and powerful means to classify the landscape into morphological classes (Jenness 2005 and 

Tagil and Jenness 2008).  TPI is a simplification of the Landscape Position Index described by Fels and Zobel (1995) and 

developed by Weiss (2001). 

TPI for each cell is calculated by subtracting the mean elevation of its neighborhood from its own elevation value.  A 

positive value indicates the pixel is higher than its neighbors, while a negative value indicates it is lower. This simple 

classification is a useful means of mapping topographic depressions. Groups of pixels with negative TPI scores represent 

such depressions, and are possible wetland locations. 

A Digital Elevation Model (DEM) is the only data required to calculate TPI.  An ArcGIS Model Builder was used to create 

the TPI (Fig. 9).  Selecting appropriate neighborhood settings is an important part of the process. Selecting too small of a 

neighborhood will result in very fine resolution which is not adequate for detecting topographic depressions over large 

areas.  For this project, the neighborhood setting of 240 meter circle radius was used. The focal statistics 

neighborhood settings were specified as a circle with radius 240, and statistics type as mean. The output of this 

process is a mean elevation raster. The minus tool subtracts the mean elevation raster from the original DEM. The 

final result is the TPI raster. 

 

 

Figure 6.  The ArcGIS Model Builder for calculating the TPI. 
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7.2.3 Compound Topographic Index (CTI) 
The Compound Topographic Index (CTI) is a function of both the slope and the upstream contributing area.  CTI can be 

calculated as:  

CTI = ln (As / (tan(β)),  

where As =  contributing area and β is the slope expressed in radians.  Slope and flow direction were calculated using the 

TauDEM tool (Tarboton 2003).  Flow direction was calculated using the D-Infinity (D-inf) algorithm.  Flow direction was 

then used to derive the contributing drainage area, also using TauDEM.  The slope grid and contributing area were then 

plugged in the equation for CTI.  

Prior to calculating the CTI topographic depressions (sinks) were removed to generate a "sinkless" DEM.  A python script 

was written to batch process the CTI.   

7.2.4 Average elevation of first returns 
The LiDAR datasets include elevation information (in meters above sea level) for various classes of returns.  Returns are 

classified by time intervals (i.e. the length of time between the moment a light pulse is emitted from the sensor and the 

moment the same light pulse – or portions of that pulse – is received by the sensor after reflecting off the earth’s 

surface).  LiDAR information is stored as geographically-explicit points in a LAS file and the ArcGIS LAS to Raster tool is 

used to extract information from the LAS files while converting the data to raster format.  The average elevation of the 

first returns was derived from the LiDAR dataset by filtering the LAS file for the appropriate return class(es) and using a 

binning interpolation method that assigns output cell values with the average elevation value of points within a cell and 

filling voids (i.e. cells that do not contain any LAS points) by assigning those cells as No Data. The average elevation of 

first returns was used to distinguish differences in vegetation height in order to classify scrub-shrub and forested 

wetlands. 

7.2.5 Average intensity of bare earth returns 
LiDAR datasets also include information on the intensity, or strength, of the signal that is received by the sensor.  

Intensity is known to be correlated with surface moisture where signal strength is diminished when the signal interacts 

with water.  A portion of returns are classified as bare earth, or ground returns, and represent the longest time interval 

between light pulse emission and reception.  The average intensity of bare earth returns was produced using the ArcGIS 

LAS to Raster tool to filter the LAS datasets for ground returns and using a binning interpolation method to assign output 

cell values with the average intensity value of all points within a cell and using the No Data void fill method. 
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7.4 Layerstack 
The input to the eCognition (Trimble 2010) segmentation process (described in section 8.2) is a tiff layerstack and the 

raw spring 2009 aerial imagery. The processes for creating the tiff layer stack are summarized in Fig. 7.  These processes 

largely relied on python scripting to ensure consistency and efficiency in the processing steps. The DEM and the LiDAR 

DEM derivatives were processed for each of the 94 buffered watershed boundaries (described in section 8.1). These 

products were then mosaicked and clipped to the northeast project area boundary, and became input rasters for the 

layerstacks. The LAS rasters were created from the filtered LAS datasets that intersected each of the 94 watersheds 

(original extent is the quarter quarter-quad LAS tiles), mosaicked and then clipped to the northeast project area 

boundary to produce 80 watershed rasters. (This means that the LiDAR derivatives from the DEM were clipped and 

processed for the full extent of all the original 94 buffered watersheds.)  A DEM No Data mask was created for each 

watershed and used to define the area of interest (AOI) as part of the image segmentation process.  Each final tiff 

layerstack consisted of the following layers: 

1) DEM 

2) DEM No Data Mask 

3) Slope 

4) TPI 

5) CTI 

6) Average Elevation of 1st Returns 

7) Average Intensity of Bare Earth Returns 

7.5 SSURGO analysis 
An ordinal map based on the predominant soil water regime (SSURGO soil map derivative) will be used as ancillary data 

in the NWI update for northeast Minnesota.  The variables included in the analysis to create the soil water regime map 

are those most likely to be related to wetland water regime (i.e. drainage class, flood frequency for April, pond 

frequency for April, and pond frequency for August).  The drainage class, April flood frequency, April pond frequency, 

and August pond frequency fields are concatenated and the results sorted on the concatenated field.  The resulting table 

includes water regime classes for all soil components.  Map units may contain more than one component.  Therefore, 

the data must be summarized to the map unit level.  The water regime field is used as an indicator of wetness intensity 

from 0 to 8 with higher numbers indicating wetter, more permanent water regimes (Table 6).  This water regime index is 

used as a guide in the classification and photo interpretation process as the SSURGO soils data does not take into 

account anthropogenic changes such as tile draining.  

7.6 Limnetic and littoral subsystem delineation 
The lake bathymetry data (DEM) were utilized in an iterative semi-automated process to create limnetic (L1) and littoral 

(L2) features for each lake in the project area.  The rasterized data of the DEM was converted to polygon features where 

any cell with a depth value of 8.2021 ft. (2.5 m) or greater is classified as L1 and any cell with a depth value less than 

8.2021 ft. is classified as L2.   

Since the bathymetric data available could not be used to delineate an accurate boundary for lake shorelines, only the 

L1 features and those L2 features that are contained within L1 features (that may represent shallow areas surrounding 

islands, for example) were selected from the results of the aforementioned process.  These selected L1 and L2 features 

were then “burned” into the segments produced via the eCognition image segmentation process.  Shoreline boundaries 

were delineated as part of the eCognition segmentation process.  Littoral zones that occupy the area between the L1 

features and the lake shoreline were manually classified as such.  For any lakes that were not included in the available 

bathymetry datasets the USGS digital topographic maps were consulted and a L1/L2 boundary was approximated 

manually.  
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Figure 7.  Method for creating the Layerstack for input into the segmentation process.  

 

3 
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Table 6. SSURGO water regime values 

 

Water Regime Description Values for Concatenated Field 

0 

All excessively drained, somewhat excessively drained, and well 
drained soils as well as udorthents, udipsamments, pits, and 
gravel. This water regime level also includes moderately well 
drained soils and somewhat poorly drained soils that do not 
flood. 

Null-Null-Null-Null (Pits, Udipsamments); Excessively 

drained-None-None-None; Moderately well drained-

None-None-None; Null-None-None-None; Somewhat 

excessively drained-None-None-None; Somewhat 

excessively drained-Rare-None-None; Somewhat poorly 

drained-None-None-None; Well drained-None-None-

None 

1 

This water regime level includes moderately well drained soils 
and somewhat poorly drained soils that do flood at least rarely. 
(floodplain formations) This is similar to Cowardin’s temporarily 
flooded “A” water regime. 

Moderately well drained-Occasional-None-None; 

Moderately well drained-Rare-None-None; Somewhat 

poorly drained-Frequent-None-None; Somewhat poorly 

drained-Occasional-None-None 

2 
Poorly drained and very poorly drained soils that neither flood 
nor pond. This is similar to Cowardin's saturated “B” water 
regime. 

Poorly drained-None-None-None; Very poorly drained-

None-None-None 

 

3 
Poorly drained soils that occasionally flood during spring (almost 
all floodplain formations). Similar to Cowardin’s “A” or “C” water 
regime depending on the length of flooding. 

Poorly drained-Occasional-None-None 

 

4 
Very poorly drained soils with frequent spring flooding, but no 
ponding (almost all floodplain formations). Similar to Cowardin’s 
seasonal “C” water regime. 

Very poorly drained-Frequent-None-None 

 

5 
Very poorly drained soils with frequent spring flooding and spring 
ponding (almost all floodplain formations). Similar to Cowardin’s 
seasonal “C” water regime. 

Very poorly drained-Frequent-Frequent-None 

 

6 
Very poorly drained soils with no flooding, but that do have 
spring ponding (almost all depressional formations). Similar to 
Cowardin’s seasonal “C” water regime. 

Very poorly drained-None-Frequent-None 

 

7 
Very poorly drained soils with ponding throughout most, if not all 
the year (marsh). Similar to Cowardin’s “F” or “G” water regime. 

Very poorly drained-None-Frequent-Frequent 

 

8 Map units designated as water (non-soil). Similar to “H” WR Null-Null-Null-Null (Water) 



 Ducks Unlimited, Inc.                                                                  27                                    Northeast MN NWI Update Technical Document 
 

 

8.0 NWI classification process 

 
The NWI classification process for northeast Minnesota consists of two basic steps:  1) creation of image segments 

(polygons), and 3) manual photo interpretation and classification of the image segments.  A detailed description of each 

of the steps is described in the sections below and outlined below.   

The layerstack (described in previous section) and the 2009 spring 4-band imagery was input into eCognition software to 

create the image segments.   

The goal of the image segmentation process was to have the photo interpretation team spend the vast majority of their 

time interpreting wetland classes that are difficult to classify instead of digitizing boundaries.  The gain in efficiency 

allowed the photo interpreters to spend more time on difficult classesand focus on increasing classification accuracy.  

The intent was to allocate most of the delineation effort to making minor edits to existing polygons rather than on 

manually creating a new polygon for each wetland feature, which serves as an enhancement to the more traditional 

photo interpretation of the imagery of heads-up digitizing.   

Each of the segments were viewed, edited (e.g. merged with neighboring segments of the same class or cut to exclude 

an area), and assigned a final NWI classification based on the previously described imagery and data (see sections 4 and 

7).  This process was performed and repeated on a section-by-section basis according to a USGS HUC 10 watershed tiling 

scheme (described in section 8.1). Once a watershed was completed, the segments were dissolved based on NWI 

attribute and run through an iterative quality control process that checks for overlaps, gaps and approved NWI codes. 

The draft version of the NWI classification for the watershed was sent to the MN DNR for review.  Once the review was 

completed, the watershed was merged into a seamless state-wide layer.  The final NWI layer for the northeast project 

area was projected to Albers equal area projection for delivery to the U.S. Fish and Wildlife Service.  

 

8.1 USGS HUC 10 watershed tiling scheme 
The northeast Minnesota project area was divided into sections by intersecting the project area with the USGS HUC 10 

watershed GIS data layer (available for download from the USDA Geospatial Data Gateway at 

https://gdg.sc.egov.usda.gov).  This divided the project area into digestible pieces for segmentation and interpretation. 

Additionally, this division allowed for a means by which to track progress towards project completion.  Watershed 

boundaries were used to divide the project area under the assumption that wetlands would be unlikely to occur on the 

boundary of a watershed, which would make incorporation into the seamless NWI data layer more efficient.  The NWI 

update process described in the following sections (and progress tracking of the process) was performed on a 

watershed-by-watershed basis until the entire project area was completed. Ninety-four HUC 10 watersheds intersect the 

northeast project area.  In preparation for the segmentation process, a 30 meter buffer was created for each watershed 

boundary. The buffered watersheds were aggregated and clipped to the northeast project area boundary, resulting in a 

total of 80 watersheds in the final tiling scheme (Fig. 8). 
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8.2 Segmentation 
The spring 2009 4-band imagery and layerstack files were imported into eCognition software (Trimble 2010) to create 

the image segmentation files.  The eCognition processing rule-set performs over 250 separate operations designed to 

reduce the amount of manual editing required from the photo interpreters. These operations include: 

1. Initial  multi-resolution image segmentation 

2. Sub-processes to manage edge matching between adjacent tiles 

3. Hierarchical image object aggregation by spectral, topographic, and classification based characteristics 

4. Basic classification of image objects based on spectral and topographic parameters 

5. Smoothing of all image object boundaries (vertices no closer than 10 feet) 

6. Elimination of image objects smaller than the MMU (1/20th of an acre) 

7. Export of a final shapefile for each tile  

Improvements to the ruleset and process development were conducted by creating prototype segmentations for the 

photo-interpretation team to review. Suggestions and requests to improve the properties of the segmentation were 

made by the photo interpretation team and incorporated into subsequent versions of the segmentation process.  The 

ultimate goal was to develop eCognition based segmentation and feature extraction processes (Fig. 9) that support and 

complement the work done by the photo interpretation team rather than to try to replace human photo-interpretation 

entirely.  
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Figure 8. The HUC 10 watershed tiling scheme (yellow) used to divide the northeast Minnesota project area. 
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Figure 9. The unedited image segmentation results (red) with two wetland polygons selected (blue) displayed over the 

IR band of the primary 50cm resolution CIR imagery.  

 

We considered the image segmentation effort to be successful when we reached a point where it took less time for an 

interpreter to edit an eCognition segmentation-derived shapefile for a watershed than it would have taken for that 

interpreter to manually digitize all of the features in that watershed.  Most of the delineation was based on making 

minor edits to existing polygons rather than on manually creating new polygons for each feature. All subsequent 

segmentation process development efforts were directed toward improving the efficiency of the overall workflow in 

order to further reduce the amount of time required to complete the inventory update.   

An online tracking system was implemented where the photo-interpretation team could request processing of specific 

watersheds or suggest improvements to the segmentation process. Overall efficiency was also improved by optimizing 

the ruleset for efficient batch processing using the production oriented functions provided by eCognition Server 

software (Trimble 2010).  Additional fields (attribute, comments, field verified) were added to the image segment 

attribute table to assist in the photo interpretation process. 

8.3 Photo interpretation 
A detailed list of steps for the photo interpretation process is listed in Appendix A. 

8.3.1 Photo interpretation guide 
A photo interpretation guide has been created to assist interpreters and help standardize NWI update methodology. 

This guide includes a brief description of the wetland class and is followed by a representative photo taken during the 

field verification process, as well as aerial imagery for spring and summer in CIR and natural color. These images will help 

the interpreter identify wetland types by viewing ground photos paired with aerial photos for the same wetland type.  
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8.3.2 Photo interpretation process 
The photo interpreters viewed the segments over the spring 2010 imagery to identify wetland segments. The photo 

interpreters used the spring imagery, professional knowledge, photointerpretation guide, as well as the summer 

imagery to assign the NWI code.  Additional data layers (e.g. USGS DRG, SSURGO soils, DEM and other LiDAR-derived 

products) were also available to assist with the NWI classification.  Adjacent segments of the same class were merged.  

Segments that have multiple wetland classes or combine wetland and upland classes were cut into separate polygons to 

conform to the NWI class boundary.  Each watershed of the USGS HUC 10 tiling scheme was interpreted systematically 

until the entire area had been completed. Additional details for the photo interpretation process are provided in 

Appendix A. 

8.3.3 Quality assurance and quality control 
Quality control and quality assurance (QA/QC) programs were written to automatically check for topological (e.g. gaps 

and overlaps) as well as spatial accuracy and attribute errors within the classification after the photo interpretation 

process had been completed.  Once a watershed was completed, the interpreter executes the QA/QC program and 

corrects any identified errors before moving on to another watershed.  After successful execution of the QA/QC process 

by the interpreter, a second interpreter inspected the wetland classification to ensure consistency and accuracy of the 

wetland classification between individual interpreters.  After the second review, the NWI QA/QC lead analyst reviewed 

the overall classification for the watershed and executed a second series of automated QA/QC procedures provided by 

the USFWS. 

The draft version of the NWI classification for the watershed was then sent to the Minnesota Department of Natural 

Resources for review.  Errors found through the DNR review process were addressed prior to final production.  

Additional information on the DNR QA/QC review can be found in the Quality Assurance Project Plan for the National 

Wetland Inventory of Minnesota (DNR 2010). 

Once the review was completed, the watershed was merged into a seamless state-wide layer.  Final accuracy of the NWI 

update for the northeast project area was assessed by the Minnesota Department of Natural Resources. 

8.3.4 Merge with seamless layer 
After completion of the QA/QC of a watershed, the data was merged into a seamless NWI layer for the northeast project 

area. 

8.3.5 Final product generation 
Before final product generation, the photo interpreted segments were generalized to “smooth” the polygons so they 

look more natural for the end user. This smoothing process was accomplished by removing unnecessary vertices, thus 

reducing the storage requirements and improving the overall efficiency of the data.  The final product was delivered in 

an Albers Equal Area projection for conformance to the FWS standard as well as the Universal Transverse Mercator 

projection to conform to the Minnesota standard for geospatial data. 
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9.0 Simplified Plant Community Classification system  
In addition to the Cowardin classification system, the NWI update for Minnesota includes the addition of a simplified 

plant community classification (SPCC) based on the classification of Eggers and Reed (1997).  The 15 plant community 

classes from Eggers and Reed were re-grouped into nine simplified plant community classes with one additional class for 

non-vegetated aquatic communities (e.g. substrate types for certain systems/sub-systems including unconsolidated 

bottom, rock bottom, rocky shore, unconsolidated shore, and streambed). This simplification of the Eggers and Reed 

classification system was designed to provide information on wetland plant communities to the end users of the 

updated NWI within the bounds of what was currently possible to achieve with reasonable accuracy with remote 

sensing data. The simplified plant community classes are summarized in Table 7. 

9.1 Combining classes 
Plant community classes described by Eggers and Reed (1997) were combined to create the simplified plant community 

classification system for the Minnesota NWI update. These groupings are as follows: 

1) The Sedge Meadow, Fresh Wet Meadow, Wet to Wet-Mesic Prairie, and the herbaceous form of the Calcareous 

Fen classes were combined into a single simplified Inland Wet Meadow class. 

2) The various bog types and subtypes of Eggers and Reed were combined into a single simplified Peatland class. 

3) The Shrub-Carr, Alder Thicket, and the shrub form of the Calcareous Fen classes were combined into a single 

simplified Shrub Wetland class. 

 

 

 

 

Table 7: Simplified plant community classes 

 Modified Plant Community Class Eggers and Reed Plant Community Class 

1 Seasonally Flooded Basin Seasonally Flooded Basins - 16B 

2 Wet Meadow Sedge Meadow - 13A 
Fresh (Wet) Meadows - 15B 
Wet to Wet-Mesic Prairies - 15A 
Calcareous Fens (Herbaceous Type) - 14A 

3 Shallow Marsh Shallow Marshes - 13B 

4 Deep Marsh Deep Marshes - 12B 

5 Shallow Open Water Community Shallow Open Water Communities -16A 

6 Peatland Open Bog (Herbaceous Type) - 10A 
Open Bog (Shrub Type) - 7A 
Coniferous Bogs - 4A 

7 Shrub Wetland Shrub-Carrs - 8B 
Alder Thickets - 8A 
Calcareous Fens (Shrub Type) - 7B 

8 Hardwood Wetland Hardwood Swamps - 3B 
Floodplain Forests - 3A 
 

9 Coniferous Swamps Coniferous Swamps - 4B 
 

10 Non-Vegetated Aquatic Community NA 
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9.2 Classification cross-walk to Cowardin 
Implementing this simplified plant community class was primarily a process of re-coding from the Cowardin classification 

system including wetland classes, subclasses, water regime modifiers, and special modifiers to the simplified plant 

community class. The applicability of the cross-walk between the Cowardin classification system and the simplified plant 

community classification system requires special attention to how the Cowardin codes were applied. This cross-walk is 

summarized in Table 8 and described by the following steps: 

1) Split the Cowardin palustrine emergent class (PEM) across four simplified plant community classes based on 

water regime: Seasonally Flooded Basins (PEMA), Inland Wet Meadow (PEMB), Shallow Marshes (PEMC & 

PEMF), and Deep Marshes (PEMH).  

2) There is some potential for class confusion between simplified Inland Wet Meadow class and the Seasonally 

Flooded Basin class. Particular attention is required during the photo-interpretation of the temporarily flooded 

(A) water regime for the PEM class to ensure proper class separation. The Eggers and Reed classification key 

states that Seasonally Flooded Basins are often cultivated or dominated by annuals such as smartweed and wild 

millet. Wetlands with photo-signatures indicating dominant plant communities are obligate wetland species 

(such as Typha) should not be classified as PEMA. 

3) Split the Cowardin PAB class across Deep Marshes (PABF) and Shallow Open Water Communities (PABH) based 

on water regime.  

4) Split the Cowardin forested wetland class (PFO) into Coniferous Wetland (PFO2 & PFO4) and Hardwood Wetland 

(PFO1) plant community classes based on sub-class with the exception of the coniferous wetlands that should be 

placed in the peatland class (see rule 5). 

5) The peatland community class crosses the PEM, PSS, and PFO Cowardin classes. Additional interpretation 

beyond what is typically required for the NWI is needed to effectively separate the peatland community class. 

Wetlands that have photo-signatures that indicate closed canopy black spruce stands, sphagnum-moss/leather-

leaf, sphagnum/sedge, sphagnum/tamarack, or possessing other peatland indicators such as the characteristic 

open water moat will be assigned a new special modifier (q) that will then be used to complete the cross-walk 

for the simplified peatland community class. 

 

NOTE: This peatland community class is most closely related the Eggers and Reed bog classes, but the relationship is not expected to 

be perfect. According to Eggers and Reed, bogs have the following plant characteristics: 

 Tamarack (PFO2) and/or black spruce (PFO4)  are dominant; growing on a continuous sphagnum moss mat and acid, peat 

soils 

 Shrubs are ericaceous and evergreen (PSS3, PSS4) growing on a sphagnum moss mat layer; peat soils are acidic 

 Sphagnum moss mat on acid peat soils; leatherleaf, pitcher plants, certain sedges, and other herbaceous species (PEM) 

tolerant of low nutrient conditions may be present 

The presence of a sphagnum moss mat and ericaceous shrubs can usually be photo-interpreted. In some cases, the tree canopy can 

be too dense to view the underlying layers. However, depending upon the characteristics of the tree canopy, the presence of a 

sphagnum mat can be inferred. The Native Plant Community Classification System refers to some wetlands with extensive sphagnum 

coverage as poor fens. Eggers and Reed do not make this distinction. These poor fens are difficult to separate from bogs without 

detailed field studies. In fact, fens and bogs may occur within the same wetland complex. 
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Table 8: Cross-walk from Cowardin to simplified plant community class 

System Subsystem Class Subclass Water Regime Code Modifier Plant Community Class 

Lacustrine 

Limnetic 

Rock Bottom   H L1RBH   Non-Vegetated Aquatic Community 

Unconsolidated Bottom   H L1UBH   Non-Vegetated Aquatic Community 

Aquatic Bed   H L1ABH   Shallow Open Water Community 

Littoral 

Rock Bottom 
  F L2RBF 

  Non-Vegetated Wetland 
H L2RBH 

Unconsolidated Bottom 
  F L2UBF 

  Shallow Open Water Community 
H L2UBH 

Aquatic Bed 
  F L2ABF 

  Shallow Open Water Community 
H L2ABH 

Rocky Shore 
  A L2RSA 

  Non-Vegetated Aquatic Community 
C L2RSC 

Unconsolidated Shore 
  A L2USA 

C L2USC 

Emergent 2-Nonpersistent 
F L2EM2F 

  Shallow Open Water Community 
H L2EM2H 

Riverine 

Lower Perennial 

Rock Bottom 
  F R2RBF 

  Non-Vegetated Aquatic Community 
H R2RBH 

Unconsolidated Bottom 
  F R2UBF 

  Non-Vegetated Aquatic Community 
H R2UBH 

Aquatic Bed 
  F R2ABF 

  Shallow Open Water Community 
H R2ABH 

Rocky Shore 
  A R2RSA 

  Non-Vegetated Aquatic Community 
C R2RSC 

Unconsolidated Shore 
  A R2USA 

C R2USC 

Emergent 2-Nonpersistent 
F R2EM2F 

  Shallow Open Water Community 
H R2EM2H 

Upper Perennial 

Rock Bottom 
  F R3RBF 

  Non-Vegetated Aquatic Community 
H R3RBH 

Unconsolidated Bottom 
  F R3UBF 

  Non-Vegetated Aquatic Community 
H R3UBH 

Aquatic Bed 
  F R3ABF 

  Shallow Open Water Community 
H R3ABH 

Rocky Shore 
  A R3RSA 

  Non-Vegetated Aquatic Community 

C R3RSC 

Unconsolidated Shore 
  A R3USA 

C R3USC 

Intermittent Streambed 
  A R4SBA 

C R4SBC 
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Table 8: Cross-walk from Cowardin to simplified plant community type 
(continued) 

System Subsystem Class Subclass Water Regime Code Modifier Plant Community Class 

Palustrine Palustrine 

Rock Bottom 
  F PRBF 

  Non-Vegetated Aquatic Community 
H PRBH 

Unconsolidated Bottom 
  F PUBF 

  Shallow Open Water Community 
H PUBH 

Aquatic Bed 
  F PABF   Deep Marsh 

H PABH   Shallow Open Water Community 

Unconsolidated Shore 
  A PUSA 

  Non-Vegetated Aquatic Community 
C PUSC 

Moss-Lichen  B PMLB q Peatland 

Emergent 

1-Persistent 

A PEM1A   Seasonally Flooded Basin 

B PEM1B 
not q Wet Meadow 

q Peatland 

C PEM1C 
  Shallow Marsh 

F PEM1F 

2-Nonpersistent 
F PEM2F 

  Deep Marsh 
H PEM2H 

Scrub-Shrub 

1-Broad-leaved deciduous 

A PSS1A 

  Shrub Wetland B PSS1B 

C PSS1C 

2-Needle-leaved deciduous 

A PSS2A   Shrub Wetland 

B PSS2B 
not q Shrub Wetland 

q Peatland 

C PSS2C   Shrub Wetland 

3-Broad-leaved evergreen B PSS3B q Peatland 

4-Needle-leaved evergreen 

A PSS4A   Shrub Wetland 

B 
PSS4B not q Shrub Wetland 

PSS4B q Peatland 

C PSS4C   Shrub Wetland 

Forested 

1-Broad-leaved deciduous 

A PFO1A 

  Hardwood Wetland B PFO1B 

C PFO1C 

2-Needle-leaved deciduous 

A PFO2A   Coniferous Wetland 

B PFO2B 
not q Coniferous Wetland 

q Peatland 

C PFO2C   Coniferous Wetland 

4-Needle-leaved evergreen 

A PFO4A   Coniferous Wetland 

B PFO4B 
not q Coniferous Wetland 

q Peatland 

C PFO4C   Coniferous Wetland 

Water regimes shaded blue are the most likely regime for the associated Cowardin class 
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9.3 Data processing for SPCC 
Geoprocessing functionalities within ArcGIS were utilized to generate a script to populate the SPCC based on the NWI 

code (Fig. 10).  There were no additional input data, hardware and software required. The script can be run under any 

ArcGIS desktop environment.  The following lists the general steps of developing, testing, deploying, and distributing the 

script. 

 

1) Write the python script in Notebook and saved it into a .py file.  
2) Test the script and check the field to see if it’s correctly populated.  
3) Import into ArcToolbox as an arctool with a user-friendly interface.  

 

 

Figure 10.  An example of part of the SPCC code. 
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10.0 Simplified key for hydro-geomorphic classification  

10.1 HGM Classification Overview 
A simplified Hydro-Geomorphic (HGM) Classification was created for the updated NWI for Minnesota based on the rules 

listed in this section (see Fig. 11-15).  A geoprocessing script was created to automate the simplified HGM classification 

for the northeast project area.  Every polygon in the NWI data layer has an HGM attribute for landscape position, 

landform/waterbody, and water flow path. The allowable classes are provided in Table 9.

 

10.2 Data Requirements and Layer Generation 
The required data layers to perform the HGM classification on the updated NWI are: 

1) Northeast MN NWI layer with valid NWI codes 
2) MN DNR streams data 
3) Slope layer generated from DEM (raster format) 
4) Public Water Inventory (PWI) Basin Delineations 
5) Landscape position mask (described below) 

 
The following six attribute fields are required to be added to the updated NWI layer: 
 

1) Landscape 
2) Landform 
3) Water flow 
4) Secondary water flow 
5) HGM Name 
6) HGM Code 

 
 
 
 
 

Table 9: Allowable HGM classes for the Minnesota NWI update 

Landscape Position Landform/Waterbody Water Flow Path 

Lentic 
Lotic River 
Lotic Stream 
Terrene 

Island 
Fringe 
Floodplain 
Basin 
Flat 
Slope 
Peatland 
 

Inflow 
Outflow 
Throughflow 
Bi-directional Non-tidal 
Vertical flow 

Lake 
Lake Floodplain 
River 
Pond 
Pond Floodplain 
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10.2.1 Derived data layers 
Two additional layers were developed from the MN DNR stream data.  The first layer is a flooding stream layer that is 

used later to define the extent of the lotic landscape component.  The flooding stream layer was created by deleting all 

of the drainage ditches, connectors and small streams from the stream layer. Small headwater streams and artificial 

channels were generally found not to have developed flood inundation areas.  A visual review of the flooding stream 

layer was conducted and any stream without a visible floodplain was deleted.   

The second layer is a stream layer for the water flow path analysis.  All streams were used and visually reviewed for 

accuracy.  The visual review of the stream layer digitized any stream that did not completely connect with a lake or any 

missed stream that would affect the water flow path analysis.   

A landscape position mask was created in order to identify the landscape position component of the HGM class.  The 

mask consists of identifying the lentic and lotic landscape positions and the remaining areas were considered terrene.  

The lentic and lotic landscape position were created from the ordinary high water mark delineation of lakes from the 

Minnesota Department of Natural Resource’s Public Water Inventory (PWI) basin layer and the flooding streams layer as 

described below. 

To identify the lentic landscape position, a lentic layer was derived from the PWI.  The PWI basin layer contains both 

wetlands and open water bodies delineated to the ordinary high water mark.  A spatial selection was done between the 

PWI layer and all lacustrine wetlands within the NWI.  A reverse selection was performed to identify any feature within 

the PWI that was not associated with a lacustrine wetland within the NWI.  These features were reviewed for accuracy 

and deleted.   The remaining PWI basins were then used to create a lentic landscape position feature class. 

To identify the lotic landscape position, a riparian area layer was derived from the flooding stream layer and the DEM.  A 

slope grid was first calculated on the DEM layer, which was used to create a fractional slope grid (rise over run). The 

fractional slope grid was used in conjunction with the stream floodplain layer to run a cost-distance analysis, where the 

flooding stream layer was the source feature and the fractional slope was used as the cost.  The results from this analysis 

provided an approximation of the height above the nearest stream.  A threshold classification approach was used to 

select a height above the nearest stream that corresponds to the extent of the riparian area (Table 10). This threshold 

was selected based on visual inspection of the DEM, aerial photos and FEMA floodplain delineation, where available. 

A landscape position classification layer was made by combining the lentic and lotic layers. Lentic features were given 

priority over lotic features when they overlapped. Any areas within the project boundary not covered by either lotic or 

lentic features were assigned to a terrene class. A final inspection of the lotic feature class was performed to remove any 

small polygons surrounding the lentic features.   

In order to assign slope wetlands to the Landform type, a two percent slope layer was created using the DEM.  A percent 

slope grid was calculated from the DEM and all areas greater than two percent slope were identified.  Any cell with a 

value of two percent slope or less was reclassified with a value of 1.  Any cell with a value of greater than two percent 

was reclassified to a value of 2.   
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Figure 11.  A ModelBuilder Model of the HAS Processing Steps. 
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Table 10: Steps to Perform a Height Above Stream Analysis 

1) Extract the desired stream/river features for the project area from a stream GIS data 

layer such as DNR 24K Streams or the National Hydrography Dataset (NHD) for your 

desired project area (e.g. Analysis Tools>Extract>Clip).  

2) Extract, clip, or mosaic the DEM as needed to match your project extent (e.g. Spatial 

Analyst Tools>Extraction>Extract by Rectangle). 

3) Use the “Copy Raster” tool to set 0 values to Null (Data Management>Raster>Raster 

Dataset>Copy Raster). 

4) Calculate the slope grid from the DEM selecting the output to be expressed as percent 

slope not degrees (Spatial Analyst>Surface>Slope). Make sure that the vertical and 

horizontal units are the same, or use a conversion factor to make the units the same. 

5) Use raster calculator to convert the percent slope to fractional slope (rise/run) by 

dividing by 100 (Spatial Analyst Tools>Map Algebra>Raster Calculator). 

6) Run a cost-distance analysis (Spatial Analyst Tools>Distance>Cost Distance). The source 

data is the selected stream/river features extracted in step three. The cost raster is the 

fractional slope grid created in step six. 

7) In order to convert the raster to polygons and manipulate the features (dissolve, select, 

etc.), first convert the raster values to integer (Spatial Analyst Tools>Math>Int).  

8) To remove values more than a certain height above the stream, use a con statement 

(Spatial Analyst Tools>Conditional>Con). The input raster is the integer raster created in 

step 10, the expression is the SQL expression to select only the values you want in the 

output (e.g., VALUE <= 3), the input true raster is the same as the input raster, and the 

input false raster should be left blank. This means that if a pixel is less than or equal to 3 

(meters above stream), the output includes that pixel, but if the value is 4 or greater the 

output does not include that pixel. 

9) Convert the raster layer to polygon features (Conversion Tools>From Raster>Raster to 

Polygon). 
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10.3 HGM Classification Process 
The model inputs are: 1) NWI layer with the following fields: landscape, landform, water flow, secondary water flow, 

HGM_Name, and HGM_Code; 2) landscape position mask; 3) two percent slope layer; 4) stream water flow layer; and 5) 

lentic layer. 

The model is composed of six primary steps: 1) assignment of landscape position, 2) assignment of landform classes 

within the lentic landscape position, 3) assignment of landform classes within the lotic landscape position, 4) assignment 

of landform classes within the terrene landscape position, 5) assignment of water flow path, and 6) quality control 

review and assignment of secondary waterfowl path (Fig. 12). 

The landscape position mask was used to assign the lentic, lotic and terrene landscape positions to all of the NWI 

wetlands.  A majority rule was used for wetlands intersecting multiple landscape positions within the mask.  The lotic 

position was further sub-divided by using the NWI riverine class (15 feet wide and larger) and assigning those wetlands a 

lotic river position with any remaining lotic positions being assigned lotic stream. Defining the landscape position 

restricts the potential landform classes that can be assigned to any given wetland. For example, lentic and lotic 

landscape positions cannot have slope landforms. 

Wetlands within the lentic position were classified into landform types fringe, basin or flat based on NWI water regime.  

Wetlands with a semi-permanently flooded (F) water regime were assigned the fringe landform type.  Wetlands with a 

seasonally flooded (C) water regime were assigned a basin landform type and any remaining lentic wetlands were 

assigned the flat landform type. 

 

 

Figure 12.  HGM classification flow chart. 
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Wetlands within the lotic position were classified into landform types fringe, floodplain, or reclassified into the terrene 

landscape position. Wetlands with an unconsolidated shore class or semi-permanently flooded (F) water regime were 

assigned the fringe landform type.  Wetlands with a temporarily flooded (A) or seasonally flooded (C) water regime were 

assigned the floodplain landform type.  All wetlands within the lotic position with a saturated (B) water regime were re-

classed to the terrene landscape position.  The saturated water regime was characteristic of bog wetlands which are 

mostly associated with the terrene landscape position. 

Wetlands within the terrene position were classified into landform types of fringe, basin, flat or slope based on the 

water regime or two percent slope layer.  Wetlands with a semi-permanently flooded (F) water regime were assigned 

the fringe landform type.  Wetlands with a seasonally flooded (C) water regime were assigned the basin landform type 

and wetlands with a temporarily flooded (A) water regime were assigned the flat landform type.  Wetlands with a slope 

greater than two percent were assigned the slope landform type (these wetlands should also generally have a saturated 

(B) water regime). 

The water flow path was assigned by determining the location of the wetland in relation to the stream layer.  If the 

stream layer ended at the wetlands, it was assigned an inflow water flow path.  If the stream layer started at the 

wetland or if the wetland was adjacent to a riverine wetland it was assigned an outflow water flow path.  If the stream 

flowed through the wetland, it was assigned a through flow water flow path.  All wetlands without stream connection 

were assigned the vertical flow water flow path.  All riverine wetlands were assigned a through flow water flow path. 

Finally, the classification process includes a step to address some situations that were not addressed by the above steps.  

Any wetland that was surrounded by open water or aquatic bed was assigned the island landform type.  Peatlands 

identified through photo-interpretation and assigned the special modifier “q” were also assigned the peatland landform 

type.  Any lacustrine open water wetland was assigned the lake landform type and any palustrine open water wetland 

was assigned the pond landform type.  Any riverine open water wetland was assigned the river landform type.  Any 

slope wetland was assigned an outflow water flow path.  Any fringe landform type with either a lentic or terrene 

landscape position was assigned a bi-directional water flow path and any wetland with a peatland modifier was assigned 

a terrene landscape position and vertical flow water flow path. 

 

Table 11.  HGM description crosswalk to HGM codes. 

 

 

Landscape Position Landform/Waterbody Water Flow Path

NAME CODE NAME CODE NAME CODE

Lentic LE Island IL Inflow IN

Lotic River LR Fringe FR Outflow OU

Lotic Stream LS Floodplain FP Throughflow TH

Terrene TE Basin BA Bi-directional Non-tidal BI

Flat FL Isolated IS

Slope SL

Lake LK

River RV

Pond PD
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Figure 13.  Landscape Position Decision Tree. 
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Figure 14.  Landform Decision Tree. 
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Figure 15.  Water Flow Path Decision Tree. 
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Appendix A: Photo Interpretation Process 

 

 

3. Import Script   

a. Input – all polygon shapefiles in W:\GreatLakes_NWI_Update\MN\EcognitionOutput\polys 

b. Backs up shapefiles to external hard drive (\\GLARO_SDE\Backup\NWI_Backup\ MN\ 

RawSegmentShapefiles) 

c. Repairs Geometry 

d. Adds fields 

i. ATTRIBUTE (Text 20) 

ii. COMMENTS (Text 255) 

iii. FIELD_VER (Text 1) 

iv. QAQC_CODE (Text 5) 

e. Loads polygon shapefiles into File Geodatabase  

i. W:\GreatLakes_NWI_Update\MN\ActiveDatabase\MN_NWI_2010.gdb 

ii. MN_NWI feature dataset 

iii. Individual Feature Classes named quadname_polys  (q3131ne_polys) 

f. Deletes shapefiles from W:\GreatLakes_NWI_Update\MN\EcognitionOutput\polys once they 

have been backed up to external hard drive and added to file geodatabase. 

g. Copies feature classes from 

W:\GreatLakes_NWI_Update\MN\ActiveDatabase\MN_NWI_2010.gdb to 

\\GLARO_SDE\backup\Nwi_backup \MN\ActiveDatabase\MN_NWI_2010.gdb 

 

1. Data layers are fed into eCognition segmentation software at GPRO (Great Plains Regional Office) 

a. DEM 

b. DEM NoData Mask 

c. Slope 

d. TPI  

e. CTI 

f. Average Elevation of 1st Returns 

g. Average Intensity of Bare Earth Returns 

h. Spring 2010 aerial imagery 

 

2. eCognition exports to GLARO 

a. segment polygon shapefile  

i. named quadname_polys  (q3131ne_polys) 

1. W:\GreatLakes_NWI_Update\MN\EcognitionOutput\polys 

2. Fields 

a. Class_name 

b. ACRES 

3. To be loaded into  MN_NWI Feature Dataset 
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5.    Pre-Photo Interpretation 

a. Using ArcCatalog, copy the watershed for editing from 

W:\GreatLakes_NWI_Update\MN\ActiveDatabase\MN_NWI_2010.gdb and paste it into 

D:\Working\NWI \MN \MN_NWI_2010.gdb in the MN_NWI feature dataset 

b. Indicate on map and tracking sheet which watershed you checked out.  This is very important to 

make sure two people are not working on the same watershed. 

c. Still in Catalog, right-click on the MN_NWI feature dataset on your computer and go to New and 

then Topology 

i. Use the default name and cluster tolerance 

ii. Select the newly added feature dataset 

iii. Use the default rank  

iv. Click Add Rule 

1. Add Must Not Overlap 

2. Add Must Not Have Gaps 

v. Finish 

vi. Topology does not need to be validated at this time 

 

4. Before starting the 1st watershed 

a. Use ArcCatalog to copy W:\GreatLakes_NWI_Update\MN\ActiveDatabase\MN_NWI_2010.gdb to 

local machine (D:\Working\NWI) 

b. Copy W:\GreatLakes_NWI_Update\MN\ActiveDatabase\MN_NWI.mxd to local machine 

(D:\Working\NWI) 

c. Install MN NWI QA/QC toolbox:  V:\Installs\GIS Misc\NWI\QAQC Toolbox\MN_WI 

d. Load Find Multipart Polygon script to ArcMap button - V:\Installs\GIS 

Misc\ArcMap_Scripts_Tools\Find_Multipart_Polygons 

e. Map B:\GLARO_SDE\Backup\Nwi_Backup\MN\PostPhotoInterpSegments – select reconnect at 

logon 
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7.   Photo Interpretation 

a. Start editing NWI watershed segment layer 

b. Merge/cut/classify polygons 

i. Make sure to look at all imagery and the topo 

ii. Check auxiliary data if unsure 

iii. Fill in attribute for all wetland polygons 

iv. If unsure, mark field verified field as “N”  

v. Leave comments if there are questions 

vi. We need to classify upland examples, but do not spent a lot of time on this step 

vii. Save edits often 

viii. Keep track of your progress on the map with graphics  

ix. Save the map document on occasion  

x. At least 1/day backup the feature dataset to W:\GreatLakes_NWI_Update\Data Backup 

  

6.    The Map Document 

a. Add feature dataset to D:\Working\NWI \MN\ MN_NWI.mxd 

i. Or change the data source to save the symbology from a previous watershed 

b. Reference grid – a simple polygon fishnet to help keep track of what has/has not been done 

c. Original NWI – this layer can be used for reference, but many codes and boundaries are suspect. 

d. SSURGO Soils – another reference layer displayed by suggested water regime 

e. Topo – USGS 1:24k topographic map. 

f. Bing Maps – Aerial 

g. CIR_2010 – 2010 Raster\MN_1FT_2010 and/or MN_HALFMETER_2010 displayed 4,2,3) 

h. TrueColor_2010  Raster\MN_1FT_2010 and/or MN_HALFMETER_2010 displayed 1,2,3) 

i. 2009 NAIP 

i. A group of county level .sid images.  Can be expanded to turn different counties on/off 

or to move them up/down in drawing order 

j. MN_NAIP_2008 
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8. QA/QC own watershed 

a. When photo interpretation on a watershed is complete, run the MN NWI QAQC toolbox tools 

from ArcToolbox or the Command Prompt 

i. All Attributes must be valid 

ii. Search and classify any NULL attributes 

iii. Double-check questionable attributes 

1. Usually mixed classes like AB/UB or EM/UB  

iv. No sliver polygons (under 0.05 acres) 

1. Merge these with neighboring polygon 

v. No PUBs over 20 acres 

1. Open water over 20 acres should be a Lake (L1 or L2) 

b. Add the Topology (say no to adding layers involved in the topology since it Is already added) 

i. Start editing segment polygon layer 

ii. Run the validate topology for entire layer 

iii. Open the error inspector and search on all rules, for entire extent. 

iv. The Must Not have Gaps rule will flag all of the outside polygons – they are ok and can 

be ignored or marked as exceptions. 

v. All other overlaps and gaps need to be corrected 

1. For gaps, use the create feature fix to make a new polygon 

i. Check to see if it should be merged with a neighbor 

2. For overlaps, use the merge fix to merge the overlap with one of the 

neighboring polygons. 

3. Save edits 

c. Re-run the sliver test from the QA/QC toolbox 

d. Save edits/stop editing 

e. Copy with ArcCatalog into W:\GreatLakes_NWI_Update\ReadyforQAQC_MN_NWI_2010 

f. Copy watershed segment layer into 

B:\GLARO_SDE\Backup\Nwi_Backup\MN\PostPhotoInterpSegements 

g. Fill out QAQC Status.xls on W:\GreatLakes_NWI_Update\Finished Geodatabases 

i. Watershed name 

ii. State abbreviation 

iii. Interpreter name 

iv. Date in MM/DD/YYYY format that watershed was completed 

v. Copied to backup – put Y to indicate the edited watershed segment layer was copied 

from local hard drive to 

B:\GLARO_SDE\Backup\Nwi_Backup\MN\PostPhotoInterpSegements 

vi. Save and close .xls 

h. Use ArcCatalog to delete watershed segment feature class from D:\Working\NWI \MN 

\MN_NWI_2010.gdb\MN_NWI 
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10. Analyst QA/QC 

a. Fill out QAQC Status.xls on W:\GreatLakes_NWI_Update\Finished Geodatabases 

b. Copy and delete from W:\ GreatLakes_NWI_Update\MN\ Finished_MN_NWI_2010.gdb 

c. Check attributes and investigate any uncommon codes 

d. Perform visual inspection on watershed  

e. Select all “U” codes and merge 

i. Select all unattributed polygons 

ii. Calculate ATTRIBUTE field with “U” 

iii. Select by attribute all “U” codes 

iv. Merge all “U” segments 

v. Select ALL segments and explode multipart features 

vi. Calculate acreage and visually check all polygons under .05 acres  

f. Run tool to check for adjacent features with the same attribute 

g. Validate and run topology (gaps and overlaps) and fix any errors 

 

Continued on next page… 

9. QA/QC another interpreter’s watershed segments 

a. Copy segment data from W:\GreatLakes_NWI_Update\ReadyforQAQC_MN_NWI_2010 to local 

machine. 

b. Perform visual inspection 

c. Rerun steps 8a through 8e 

d. Copy with ArcCatalog into W:\GreatLakes_NWI_Update\Finished_MN_NWI_2010 

e. Fill out QAQC Status.xls on W:\GreatLakes_NWI_Update\Finished Geodatabases 

f. Copy watershed segment layer into 

B:\GLARO_SDE\Backup\Nwi_Backup\MN\PostPhotoInterpSegements rename with “postqaqc” at 

end. 
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…Continued from previous page 

h. Append classified segment data to Reference Data 

i. Select watershed segments by attribute  

1. “ATTRIBUTE” <> “U” 

ii. Join selected table with W:\GreatLakes_NWI_Update\Codes\NWI_Code_LookupTable 

.dbf and export attributed records to .dbf 

1. FULL_CODE (All Valid codes) 

2. Class 

3. Subclass 

4. WATER_REG 

5. Modifier 

6. Wetland 

iii. Append exported .dbf to 

W:\GreatLakes_NWI_Update\MN\RandomForest\Reference_Data\Reference_Data.dbf 

i. Export all wetland segments to database to be sent to MNDNR for review 

j. Export all segments to B:\GLARO_SDE\Backup\Nwi_Backup\MN\Finished 

k. Append individual watershed segment feature class into seamless dataset for entire project 

area:  vector.glarogis. MN_NWI_2010 

l. Run QA/QC tool box tools for MN 

i. All Attributes must be valid 

ii. No sliver polygons under 0.01 acres 

iii. No PUBs over 20 acres 

iv. No L1UBs/L2UBs under 20 acres 

m. Validate and run topology (gaps and overlaps) and fix any errors 

n. When complete 

i. Dissolve W:\GreatLakes_NWI_Update\MN\State_Level_NWI\ 

MN_State_NWI_2010.gdb 

1. Dissolve Field: ATTRIBUTE 

2. Uncheck Create multipart features 

ii. Convert result to coverage 

iii. Run GENERATE  <in cov> <out cov> 4 BendSimplify errorcheck 

iv. Delete uplands and non-attributed polygons 
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